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4th St. Sports Computer Football Manual 
Updated July 4, 2002 

Introduction 
4th St. Sports Computer Football is based on the abilities of 

professional football players and the abilities of you, as coach and 
general manager, to make these players perform for your team.  It has 
been designed to be a �turn-based� football, as opposed to a time-
based simulation, meaning that rather than being rushed to make 
decisions, you are allowed to set the play you want, move the 
defensive players to adjust to the offense, and find the result of the 
play when you are ready.   

Speaking of simulation, this game is designed to simulate 
football...not statistics.  Although many ratings in the game are based 
upon statistics, the way in which you coach a team will largely 
determine that team�s won-loss record. 

The layout of this manual follows this general outline:   
•   the ratings and how they enter in to the game 
•   the organizational and statistical aspects of the game 
•   the game itself 

It is suggested that you look over the ratings section before you 
begin, so you know a little about how the game plays.  After that, feel 
free to jump right in! 
 
The Ratings 

Each player in this game has been given a set of ratings (which can 
be displayed at nearly every phase of the program) which will decide 
whether or not he is a good player.  All ratings are designed to fit the 
game as a professional player�s talents allow HIM to fit into a game.  
For example, some tight ends are incredible blockers, but may not be 
gifted receivers.  These players will receive a blocking rating which will 
allow them to be a useful member of your team. 

Each player has 6 general ratings, which differ somewhat from 
offense to defense and position to position.  An outline of these ratings 
is listed in the table below. 
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 x A B C D E 

Offensive 
Line 

supple- 
 

power 
blocking

quick 
blocking

short 
pass 

blocking

medium 
pass blk 

long 
pass 

blocking
Average 
Ratings 

5 7 7 7 7 7 

Quarterback mental Inside 
runs 

outside 
runs  

short 
passing 

medium 
passing 

long 
passing 

Average 
Ratings 

3 5 6 7 7 7 

Running 
Back 

blocking inside 
running 

quick 
running 

short 
pass rec

short 
pass rec 

long 
pass rec

Average 
Ratings 

5 7 7 7 7 6 

Wide 
Receiver 

rating inside 
running 

outside 
running 

short 
pass rec

short 
pass rec 

long 
pass rec

Average 
Ratings 

2 5 6 7 7 7 

Tight End � inside 
running 

outside 
running 

short 
pass rec

short 
pass rec 

long 
pass rec

Average 
Ratings 

6 6 5 7 7 6 

Kicker � FG<30 
yd 

PAT 

FG<40 
yds 

FG<50 
yds 

FG>50 
yds 

Kickoffs 

Average 
Ratings 

2 NA NA NA NA NA 

Punter � Own 
side of 
50-rush 

Own 
side of 

50 

Opp 
side of 
50-rush 

Opp 
side of 
50-rush 

Kickoffs 

Average 
Ratings 

2 NA NA NA NA NA 

Defensive 
Line 

� run 
defense 

pass 
rush 

short 
pass 

defense 

medium 
pass def 

long 
pass 

defense 
Average 
Ratings 

3 3 3 1 0 0 

Linebacker � run 
defense 

blitz 
rush 

short 
pass def 

medium 
pass def 

long 
pass def

Average 
Ratings 

3 3 3 3 2 1 

Defensive 
Back 

� run 
defense 

blitz 
rush 

short 
pass def

zone 
pass def 

man 
pass def
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Average 
Ratings 

3 2 3 3 3 3 

 
At first glance at this table, you might believe that your defense 

would be best if you placed 11 defensive backs on the field at the 
same time because, except for their run defense, you would have 
better numbers on the field than with defensive linemen and/or 
linebackers.  This is not true, because ALL players have sets of result 
codes in addition to their general ratings.  Below are a few samples of 
these �rating zones� (here-after referred to as "RZ"). 

 
 
 
 
 
 
 
 
 
 
 
 
 
A listing of the code numbers in each column is given in the 

appendix.  If you look through these numbers and run a statistical 
analysis corresponding to the dice rolls, you�ll see that Joe Defensive 
Lineman has a run column (A) average of 0 yards per carry.  
Meanwhile a linebacker�s average for column A is 1 yard per carry and 
defensive back�s average is 2 yards per carry.  Therefore, having 
eleven head-hunting defensive backs on the field will not result in an 
improvement for your team�s rushing defense.  In fact, even if their �A� 
rating is better than your defensive line�s, they still may allow more 
yardage per carry. 

You have probably noticed by now that the offensive player�s ratings 
(Ray Quarterback) are higher than the defensive players.  That�s 
because the two are subtracted and compared to a 10-sided die on 
virtually every play.  For example, if a defensive player�s �A� rating 
were in question, and his grade for that rating was a 3, and an 
offensive player�s �A� rating were in question, and his grade were a 7, 

 Bob Defensive Back 
 CB  Oak �96  i -3 
 x A B C D E 
 3 2 3 3 3 4 
 2 04 47 55 55 17 
 3 55 30 46 09 66 
 4 83 48 03 65 26 
 5 04 47 84 64 46 
 6 03 47 63 46 66 
 7 04 45 02 46 46 
 8 03 46 00 46 67 
 9 85 34 34 34 34 
 10 24 26 22 26 20 
 11 35 39 37 20 17 
 12 88 88 20 17 88 
 KR- 7 N(21)  KC- 3 K 
 PR- 7 R(11,20)  PC- 3 P 
 Ret- S 11     

 Ray Quarterback 
 QB  Pit �96  i +2 
 x A B C D E 
 3 5 6 7 8 8 
 2 03 11 21 41 41 
 3 02 07 11 46 31 
 4 02 54 46 31 31 
 5 02 84 11 21 46 
 6 01 00 09 11 46 
 7 01 87 11 45 46 
 8 01 04 08 11 45 
 9 01 05 45 46 46 
 10 01 10 45 45 21 
 11 01 11 04 21 31 
 12 01 11 18 18 18 
 KR- 7 N(21)  KC- 3 K 
 PR- 7 R(11,20)  PC- 3 P 
 Ret- S 11   Aud- 6 

 Joe Defensive Lineman 
 DT  Min �96  i +0  
 x A B C D E 
 3 3 3 1 0 0  
 2 00 48 62 63 66 
 3 02 30 05 46 46 
 4 01 46 08 46 46 
 5 01 46 03 11 21 
 6 00 47 04 11 46 
 7 83 45 05 11 46 
 8 82 34 06 46 46 
 9 00 46 02 46 46 
 10 22 26 26 26 20 
 11 39 39 20 20 89 
 12 54 69 17 17 17  
 KR- 7 N(21)  KC- 3 K 
 PR- 7 R(11,20)  PC- 3 P 
 Ret- S 11      
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the computer will subtract 3 from 7 (giving 4) and compare it to a d10 
roll.  If the roll (from 0 to 9) is less than or equal to 4, the offensive 
player wins the matchup, and the play result will be read from his RZ.  
If not, the result will be read from the defensive player�s RZ.  The 
average offensive rating (for most positions) is a 7, and the average 
defensive rating (for most positions) is 3.  When two �average� players 
match up, each has a 50% chance to win the matchup. 

Any offensive player with a rating less than 7 is going to get beat on 
the majority of his matchups.  Likewise, any defensive player with a 
rating less than 3 is going to get beat a lot.   

As coach of your team, you�ll want to take advantage of the 
matchups presented on the field and attack them as best you can.  
The more mismatches you can create for your team, the better chance 
you have at winning the game.   

The computer selects one matchup on each play and focuses on it 
for a result.  Therefore, running one play over and over again (say, an 
Off Tackle to the right side with the halfback carrying the ball) will not 
yield the same matchup (and therefore, the same result) on every try.     
But the strength of your team in that area (using the Off Tackle 
example, which would go to the right side, the blocking abilities of your 
right guard, right tackle, tight end, and running abilities of your 
halfback will account for over 80% of the chances) will ultimately 
determine how successful the play is for you.  And don�t forget, the 
defense has some say in the matter, too! 
 
Installing the Game 

Windows 95 or Higher 
Insert disk #1 into your floppy drive (A: or B:) or your CD into the CD-

ROM drive.  (The CD may self-start after you close your drive door.)  
Click the Start button, and from the �Settings� option select �Control 
Panel�.  Double click on the �Add/Remove Software� icon.  Follow the 
instructions.  You may change the directory to which the files will be 
installed (the default directory is C:\4THSTFB).  If you do change the 
directory, remember this when you install any extra player disks.  
Follow the on-screen instructions to finish the process. 

If you have any extra player disks, you may now install them.  Insert 
the player disk into your floppy drive and again go to the �Add/Remove 
Software� option in the control panel.  Follow the on-screen 
instructions to finish the installation process.  The default directory for 
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the players disk will be C:\4thStFB\XXXX (where XXXX stands for the 
year for the data disk.  Example, for the 1995 season, the default 
directory would be C:\4thStFB\1995).  If you decide to change this 
directory, the subdirectory MUST be 4 characters long in order for the 
game to work. 

The setup program will create a new program group called �4th 
Street Software� and three new icons under it, �FOOTBALL�, 
�ORGANIZER�, and another for the main help file. 

If the installer is not successful, a secondary setup program is also 
available on the CD in a folder labeled �Alternative Setup�.  Use the 
file labeled SETUP.EXE inside this folder (this will install the game 
and organize programs ONLY).  Read the README.TXT file on the 
CD for further instructions, including instructions on how to install 
player disks. 

 
Manual Terminology and Keyboard Equivalences 

From here on, the terms �click�, �double-click�, and �drag� will be 
used as key words for actions that anyone familiar with computers will 
know.  Keyboard equivalents are the same as in any other 
program...you can press your Tab key to scroll through and highlight a 
particular item and press the Enter key in order to select it.  There are 
several �hot keys�, too, which can be selected by first pressing �Alt� 
and then the letter, which is highlighted.   

You can also use the keyboard to move players.  Pressing the F12 
key will place a selection square around a player.  Pressing it again 
will scroll to another player.  When a player is selected, he can be 
moved forward, backward or side-to-side using the arrow keys on your 
keyboard. 

Offensively, you may select plays from the keyboard, too.  After 
clicking on the Play button (or pressing Alt-P) to display the plays, use 
the up and down arrows to scroll through them.  Pressing the Enter 
key will select the play currently highlighted, but NOT close the play 
list.  You can scroll through the list further (and even select a different 
play by pressing Enter again) before closing the play list by either 
clicking on the OK button, or pressing Alt-O. 

 
The Programs 

The Windows program consists of two programs; FB32.EXE and 
ORG.EXE.  FB32.EXE runs only the game.  ORG.EXE runs all the 
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organizational and statistical aspects of the game.  Both can be 
accessed by double-clicking on their icons in either the program group 
or from the Start menu. 

 
Organize  (ORG.EXE) 
Setting up a League 

After the files have been installed on your computer, double-click on 
the �ORG� icon to start the organization program. 

You must now select a player file to work with.  This can be done by 
selecting �SELECT YEAR� from the FILE menu.   A window will pop 
up with the subdirectories (where the season disks have been 
installed) visible.  Select the one you want by double-clicking on it, and 
then select the player file (example, PLAR1995.apc) and press OK, or 
double-click on the player file. 

 

 
The Select Year (Open a Season File) Screen 

 
The program will automatically load the player file and display the 

League 1 teams on the screen, as pictured below. 
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The �Select Team� Screen 

 
At the top of the screen, you�ll notice four menu items. 
 

•   The File menu allows you to select a player 
file OR exit the program. 

 
•  The Setup menu will allow you to make 

changes to a league, start a new league, 
transfer players in a league to the same league in a different 
season, and release all the players in a league. 

 
• The League menu allows you to change 

leagues.  You can set up five different 
leagues using the same player file in 4th St. 
Sports Pro Football. 
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• The Options menu contains several subprograms, which will be 
covered in subsequent sections. 

 
 
 
 
 
 
 
 
 
 
 
 
If you want to alter the names of the teams in a league, or wish to set 

up your own league, click on the Setup menu after selecting the 
league you wish to work with.  (Note:  While it is not necessary to 
enter the full names of teams, it can be done for aesthetic purposes.  
The game program assumes you will do this, so some of the play-by-
play grammar may seem strange if you don�t).  If making your own 
league, be sure to select one of the unused leagues under the League 
menu before clicking on the Setup menu. 
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You may change the names in the text fields to whatever you wish.  
By leaving a field blank, you inform the computer that no team will 
reside in that slot. 

As most of the teams in �League 1� have city names and nicknames 
larger than the text �fields� shown above, you will notice the names 
beginning to scroll to the right, resulting in the apparent 
�disappearance� of part of the city name.  Don�t worry...as long as the 
full name of a team does not exceed 20 characters, all will be saved, 
and you�ll see the entire name whenever you play a game. 

After typing in new team names, press the �SAVE� button from the 
menu.  If working with League 1, when prompted, select �NO� so that 
ONLY the team names are saved...otherwise, all the players on the 
League 1 teams will be dropped from their original rosters, making it 
necessary to either reinstall the files or redraft the teams in order to 
play with them. 

Notice that conferences are separated by the top and bottom halves 
of the screen. 

To make your OWN league, go back to the original organization 
screen.  You can then switch leagues from the �LEAGUE� menu.  It is 
possible to have five different leagues (including League 1) using the 
same player file.  Select one of the other four leagues (League 2, 
League 3, etc.) as your league, then press �SETUP� AGAIN.  You will 
return to the league setup screen, at which time you can type in the 
name of your league, the name of the divisions, along with the team 
names.  When finished, press the �SAVE� menu.  When prompted, 
select �YES� in order to save the entire league and clear out any 
players, colors, etc. which may be present in the league file. 

You now have the opportunity to draft players, select team colors, 
select a coach, and set up team platoons. 
 
Drafting Players (from the Options menu) 

Drafting a player is as easy as point and click.  At the organization 
screen, select the team you would like to draft for (just click on it) 
select Draft from the Options menu.   
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The Draft Screen 

 
At the top of the screen, the name of the team drafting is listed, and 

alongside it is a text box in which you may input a 3-character 
abbreviation for the team.  (This option is NOT available in the league 
setup section because of a lack of screen space.)  The abbreviations 
are used for a variety of things, including identifying the team players 
play for in statistical functions.  It is highly recommended that you fill in 
each team�s initials before beginning league play, and certainly before 
compiling a game�s stats for the first time. 

You may also select a football helmet to represent each team.  
These files are stored (and MUST be stored) in the season directory 
(e.g.  \4thStFB\1997) as a bitmap (.bmp) file.  A helmet template 
(helm_tmp.bmp) is included with the game, which can be altered and 
saved under a different name.  You will need to resize your new 
helmet picture to .14 inches wide by .11 inches high before saving it 
(at 300 pixels per inch resolution).  This can be done in virtually any 
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paint program.  Remember to save the picture under a different name 
so you don�t destroy the original template! 

After the draft module is loaded, you will see two lists.  The list on the 
left side (player list) is the pool of players from the season you are 
working with.  The list on the right (team list) will contain the players 
(up to 100) you draft for the team. 

The players on the player list are all in alphabetical order.  There will 
be well over a thousand of them, depending upon the season you are 
working with.  (Typically, there are 55 players per pro team...1650 
players per 30 teams). 

You can find any player on the list in a number of ways.  First, you 
can scroll down by pressing on the arrows at the top or bottom of the 
list.  To jump up or down a screen, click on the scroll bar either over or 
underneath the scroll marker.   

You may also run a name search for any player you�d like.  Click on 
the far left of the text field (which is located underneath the player list) 
and type in the last name 
of the player you are 
searching for.  When the 
name has been entered, 
press �ENTER� or click on 
the �SEARCH� button (you 
can also press �Tab� to get 
to the �SEARCH� button, 
then press �Enter�).  The 
computer will locate and 
highlight the player whose 
name you typed in.  If you 
don�t know the exact 
spelling, the search will 
attempt to make a match 
so long as you input at 
least 2 letters. 

To add a player to the 
team list, highlight the 
player and then press the 
�ADD� button (or double click on the player).  His name will be added 
to the team list, and an arrow will be placed in front of his name on the 
player list, indicating that he is no longer available to be drafted in 
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THIS league.  (He MAY be drafted by teams in other leagues, 
however.)  From here on, this arrow will be referred to as an 
�unavailable arrow�. 

You can add up to 100 players on each team.  Each time an addition 
is made, the team list is reorganized so that it is alphabetical, making 
the platoon setup easier to complete. 

A player can be removed from a team by highlighting his name in the 
team list and pressing the �REMOVE� button (or double clicking on his 
name on the team list).  The unavailable arrow in front of his name will 
also disappear in the player list. 

To get a good view of a player�s talents, highlight his name and 
press the �DISPLAY� key.  His ratings, similar to those shown 
previously and to that above, will appear on the screen. 

If players remain available, you may use the "Autodraft" button to 
select one.  The computer will research your roster and select the best 
player (in its opinion!) for your team. 

While in the draft module, select a pair of team colors.  The 
foreground and background colors can be selected by clicking on the 
appropriate buttons near the bottom of the screen.  These colors are 
used throughout the program, especially in the game module, which 
makes the game more enjoyable to play and teams easier to identify. 

Again, you will also want to type in a set of team initials, which are 
used in the statistics files.  The initials can be no longer than 3 
characters. 
 
Setting Up Platoons (from the Options menu) 

In order to play the game, you should complete each of the 15 
platoons.  There are also 3 substitution groupings, which will allow the 
computer to do a better job of substituting in the event of an injury. 

From the Options menu in the organization module, click on the 
Platoons item after drafting your team.  The screen will include a list of 
the players on your team (team list), a window for the platoon 
positions, several platoon buttons (5 offense, 5 defense, 5 special 
team and 3 substitution), a �Check� button (to see if the vital platoons 
are filled in properly) and default offense and defense buttons.   

There is also an �AutoFill� button, which will automatically fill the 15 
platoons with the best available players on the current roster.  Using 
this button will automatically overwrite any platoons already present.  
The substitution groups are not filled in. 
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Although the AutoFill function will save a lot of time, the computer 
occasionally runs into difficulties selecting players due to the 
complexity of the operation.  Therefore, you should ALWAYS check 
over your platoons (use the �Check� button) after using the AutoFill 
function.  If you do leave a platoon slot open, the game program will 
detect this and close down when you attempt to play a game. 

 

 
The Platoons Screen 

 
For example, click on the �PRO SET� button.  The computer will 

change the position listings on the upper right of the screen, and if any 
players have been selected for the pro set package, their names will 
appear and unavailable arrows will appear next to their names in the 
team list. 

To place a player on a platoon, highlight his name and click on 
�ADD� (or double click on his name), or click and drag him to his 
position on the platoon.  If the player is eligible to play the position, his 
name will appear there and an unavailable arrow will appear next to 
his name in the team list. 
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To remove a player, highlight his name in the upper right of the 
screen and press �REMOVE� (or double click on his name).  The 
space on the platoon list will be vacated and the player�s unavailable 
arrow will be deleted. 

Be sure to fill out the platoons as best as you can.  This will allow 
you and the computer to be more flexible, speed up the game, and 
prevent crashes.  To make things easier, you may want to use the 
�Forward� buttons.  These automatically insert the player whose name 
appears on one platoon into the same position on all platoons of the 
same type (offense, defense, special team). 

The substitution platoons are important, as they tell the computer 
which players you prefer to have in the game if an injury, ejection, or 
rest period occurs for a starter.  For example, by listing an offensive 
lineman as �OL1� in the offensive substitution platoon, you are telling 
the machine that he is your top substitute for offensive line injuries. 

You will also want to set your default offensive and defensive 
packages at this time.  The defaults are �PRO SET� and �3-4-4�.  If 
you don�t like these, click on the platoon button you prefer, then click 
on the correct default button (offense or defense) to select it as your 
new default. 

The offensive platoons in this game are actually �packages� of 
players.  In fact, ANY package you put on the field can line up in ANY 
of the 6 formations in the game.  But keep in mind; you probably don�t 
want four wide receivers on the field when running from the two tight 
end formation!  Formations can be changed during the game, and will 
use whatever players you have on the field. 

The special teams platoons MUST be filled by appropriate players.  
Only kickers may kick field goals, and only punters may punt.  Both 
kickers and punters may kick off, although a punter who did not 
regularly kick off in actual play will not perform very well in this task. 

Returners can be any player who is either a running back, defensive 
back, linebacker, or wide receiver.  Players who actually returned 
kicks though, will perform better.  When selecting a returner, check 
out their return letters.  As is the case with all returns, a return letter of 
�A� is superior, while �S� is as bad as it gets.  See the appendix for the 
average return yardage for each return letter. 
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Player Editor (from the Options menu) 
4th St. Sports 

includes a player 
editor, which you 
can use not only 
to change player 
ratings and 
results columns, 
but also to import 
players from 
previous seasons 
into one file, 
make new files, 
and make new 
players. 

After selecting a 
player file in the Organize program, select �Player Editor� under the 
Options menu.  A new screen will appear, complete with the display of 
the first player in the file.  You may use the �Next�, �Previous�, 
�Search� and the scroll bar at the top of the screen to view and/or edit 
any player in the file. 

To import players from other files into the current file, click on the 
"Select Import File" option from the "File" menu.  You can make a 
�New� player, type in his name, then select the player from the drop 
down �import� box.  If the player exists, the rest of the player�s card will 
be filled in automatically. 

You may also make a New Player File from the File menu, and then 
fill it in with whatever players you�d like.  Follow the on-screen 
directions to name a new sub-directory (you will have to input a 4-
character name, such as �1952�) and the player file.  When finished, 
you will have the opportunity to fill in the player card for player #1 in 
your newly created file. 

Buttons at the right will automatically fill in average ratings for any of 
the positions listed.  The �Calc A�, etc. buttons will automatically 
calculate the average gain and average percent (for passes and field 
goals) of any column you select.  Use the average ratings as a 
baseline to determine how a player who is above (or below) average 
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should look like. For example, after making a new player (say, a 
running back) and then filling in his card with average ratings by 
clicking on the �RB� button, change some of the ratings to improve or 
downgrade a player.  Use the ratings and yardage information on page 
1 to assist you, and the result codes in the appendix to select proper 
codes. 

 Players may also be imported from a comma-
delimmited file, also known as a "CSV" file, which is a text version of a 
spreadsheet file.  To perform this procedure, you must first create a 
spreadsheet with four columns: Last Name, First Name, Position, and 
Team initials.   

 
(PLACE SS EXAMPLE HERE) 
 
 Once you are ready to save the file, use the "Save As" 

option of your spreadsheet program to select "comma-delimmited file". 
 Now start the organization program, load the file you 

want to import the players into, then go to the player editor.  From the 
menu in the player editor module menu, select "Name Importer". 

 
(NAME IMPORTER SCREEN) 
 
 Open each of the CSV files you wish to import into the 

player database.  If successful, the names, positions, and team initials 
of the players saved in the spreadsheet program will be displayed in 
the player list.  You then may select some or all of the players from the 
list and then Import them into the database by clicking the "Transfer" 
button. 

 
 

Selecting a Coach (from the Options menu) 
One of the most important parts of 4th St. Sports Computer Football 

is YOU, the coach!  While it is more fun (for most people) to call the 
shots as they occur during a game, you may choose to make a 
computer coach for your team, or assign one of the computer coaches 
already included.  If you are playing in a mail league, you can send 
another coach your coaching file on disk, thus eliminating some of the 
problems encountered whenever another human plays games with 
YOUR team.  The file you send includes a password which you make 
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up, preventing the other coach from reading through your file, and 
intercepting your game plan. 

From the Organization screen, click on Coach under the Options 
menu.  After loading, you�ll be at a new screen.  This is the offensive 
coaching profile of one of the coaches already made by 4th St. 
Software.  You can scroll through these coaches if you like, by 
pressing the �NEXT� or �PREV� buttons near the top of the screen.  
Or, you can 
make your 
own coach 
by pressing 
the �NEW� 
button.  The 
new coach 
will be 
added to 
the end of 
the list, and 
can be 
used on 
YOUR 
computer 
only. 
 

The Offensive Coach Profile Screen 
 

You may sort through the coaches installed with the game by using 
the scroll bar near the top of the page, or go straight to a coach�s 
record by using the �Quick Find� drop-down box. 

To produce a coaching file, make a new record by pressing on the 
�New� button.  Go ahead and fill in the coaching profile you desire, 
then select �Export� from the �Import-Export� menu.  You will be 
prompted to enter a password and to set the location of your file, 
which will then be saved. 

To select a coach for your team from those included on the hard 
drive, find a suitable coach and then just click on the �Hire� button 
near the bottom of the screen.  If using this option, it would be a good 
idea to remove the names of any skilled players from the run and pass 
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frequency areas (found in the lower right-hand corner of the screen) 
who are not actually on your team's roster. 

You can also import a file from another source (such as a floppy 
disk) if you know the password associated with the file.  This will allow 
you to integrate a separate file into the file installed onto your hard 
drive.  This function is useful for full-season replays. 

In the lower right hand corner of the screen, there are two portions 
labeled �Player Run Freq� and �Player Rec Freq�.  When you click on 
either of these buttons, a list of the players pops up from which you 
may select players for which you want to set running and receiving 
frequencies.  The maximum allowable frequency is 99.  Although the 
frequencies may be viewed as percentages, in actuality they are not.  
Setting one player�s run frequency to twice that of any other, for 
example, will not necessarily yield twice as many carries for that 
player.  There are many other factors which will influence the run and 
receiving totals of a player.  But setting one higher than another will 
result in a player being a ball carrier/receiver more frequently, provided 
he is a starting player. 

You may also select frequently used plays and seldom-used plays.  
The "Little Used" play set is very important, unless you want your 
quarterback to run with the ball several times a game, or want wide 
receiver reverses called frequently.  Putting plays on the Little Used 
list will cut these calls to a minimum.  On the other hand, putting plays 
on the Favorite play list will greatly increase a play being called during 
a game.   

After making your lists, click on the Call% scroll bars to tell the 
computer coach how frequently you want these plays called.  Setting 
the Favorite play list to 50% means that roughly 50% of your calls 
during a game will come from this list.  Of course, the game situations 
will also play a part in your play calls. 

To adjust the defensive profile of your coach, click on Defense from 
the menu.   
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The Defensive Coach Profile Screen 

 
On the defensive screen, make sure to set the Defensive Style and 

the Double Team/Key frequency. 
Although both these screens allow you to set your default offense 

and defense, they are secondary to those selected in the Platoon 
module. 

Clicking on �OFFENSE� switches you back to the offensive screen 
again. 

When you press �EXIT� from the offensive profile menu, all files will 
be saved and you will be returned to the draft program. 

 
Resting Players (from the Options menu) 

The final utility under the Options menu allows you to rest players for 
a length of time you specify.  You may rest players on one team or on 
all the teams in the league simultaneously.  This option comes in 
handy when you want to simulate a �bye� week, or a week off during 
playoffs. 

 
 

Football (FB32.EXE) 
Playing the Game 
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To play 4th St. Sports Computer Football, double-click on the FB32 
icon.  After clicking the �FILE� menu and then choosing �SELECT 
YEAR�, you will be able to select a player file.  See the Select Year 
Screen shown in the Organization section of this manual. 

After selecting a player file, the computer will show the Game 
Options screen so that you can decide what rules you want to play by. 

 

 
The Game Options Window 

 
There are several different options you can select from, including the 

yardline where the kickoff takes place, the spot at which the goal post 
is, missed field goal rules, etc.  You can also decide upon the identity 
of each coach.   

 There are AutoPlay Options, too.  Selecting Autoplay 
will run the game in fast mode. (Be sure to set both coaches to a 
computer identity when using this option.)  Selecting Run Sched will 
allow several games (even a season�s worth) to be run (via autoplay) 
at one time.  Again, make sure you set the identity of each coach to a 
computer. 

The �PRE-SPECIFIED� options can only be used if a coach has 
been pre-selected for the team in question.  This is done in the 
Organization program from the coach menu, as explained earlier.  
Selecting �BUD�, �JOHN�, �TOM�, or �CHUCK� will give control of your 
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team to one of the four Hall of Fame coaches.  Select �PATH�  if you 
have received a coaching file from your opponent. 

When you are satisfied with your selections, press the �OK� button.  
You can access the Game Options window again at the team 
selection screen if you change your mind about anything. 

After setting the game options, the computer will load the �League1� 
teams.  If you want a different league, select one from under the 
�LEAGUE� menu. 

 

 
Team Selection Screen 

 
Select the visiting team by clicking on it and clicking the Visitor 

menu.  Do the same to select the home team, except click on the 
Home menu. 

After setting the game options, press �DONE� to begin play. 
 

Autoplay and Run Schedule 
After selecting the two teams which are about to play, you may click 

on the �Autoplay� checkbox in the game options window.  In order to 
use this option, both teams must be under computer coach control. 

Selecting �SCHEDULE� from the Football menu will allow you to set 
up and play a schedule of up to 20 weeks.  A file named �SCHEDULE� 
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is in the player file directory, and includes the  week-by-week 
professional football schedule for the season selected. 

You may change leagues from the �LEAGUE� menu, as always. 
To add a game to the schedule, scroll through the teams until you 

find one you want, then click on the appropriate button (�HOME� or 
�VISITOR�).  Do the same for the other team, then press the 
�ACCEPT� button.  The game will be added to the schedule on the 
right.  A game may be removed from the schedule by selecting it and 
clicking the �REMOVE� button.  Clicking on the �Next Week� button 
will switch to the next week on the schedule. 

If you plan on playing through a certain week on the schedule, 
change the �Play Through� scroll bar to the appropriate week.  Setting 
the �Play Through� to 20 (or the maximum number of weeks) will play 
the entire schedule.  On a 166 MHz machine, it typically takes about 
30 minutes to play an entire schedule.  On a 1.3 GHz machine it 
typically takes 5-10 minutes. 

 

 
The Schedule Maker Screen 

 
To run a schedule, the  �Run Schedule� checkbox must be checked 

in the Game Options window.    Pressing the "Done" menu item will 
begin scheduled play. 
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As each game is played, games are deleted from the schedule.  
Therefore, it is wise to back up the schedule before beginning play.  A 
file named �SCHEDULE.BAK� is present in your player file directory, 
which is a backup to the SCHEDULE file.  The SCHEDULE file 
contains the schedules for ALL 5 LEAGUES. 

As with Autoplay, it is necessary to select computer coaches for both 
home and visiting teams before running a schedule.  You�ll usually 
want to use the pre-specified option. 

The schedule maker can also be accessed under the Options menu 
in the Organization program. 
 
Beginning the Game 

The game will begin with a coin flip.  If you win, you will have the 
option of kicking off or receiving the kick.  If you elect to kick, you will 
have the opportunity to select from a normal (deep) kickoff, a squib 
kick, or an onside kick.  A deep kick will most probably be returned by 
the other team�s primary kick returner (usually, their best returner).  A 
squib kick will probably NOT be returned by the primary return man, 
but the opposing team is almost guaranteed good field position, 
unless the man returning the kick is totally inept.  Onside kicks, if not 
recovered by the kicking team, give the receiving team excellent field 
position. 

All game functions are run from the bottom and top of the screen.  
Buttons will appear at the bottom, allowing you to initiate an action.  
They may be selected either with the mouse or with the Enter key.   

The menu contains many options that you will want to become 
familiar with. 
 
Playing Defense 

Defensive play calling is probably the most important part of 4th St. 
Sports Computer Football.  If you can contain the opposing team, you 
will allow your offense to have better field position, thereby increasing 
the odds of you pulling out a win. 

Your defense is made of up eleven labels, which are named after 
your defensive players.  To change the players on the field, either 
change the defensive package or go to the substitution module (both 
options are under the �DEFENSE� menu). 
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The Game Screen 

 
You will also have to decide if you want to run a high-risk or low-risk 

type of defense.  You can run blitzes, key and double team ball 
carriers and receivers, and call for zone or man defenses.  All of these 
options (except blitz) are under the �DEFENSE� menu. 

Below is a brief description of some of the aspects of defense in 4th 
St. Sports Computer Football: 

Coverage 
• Zone---Zone coverage allows you to move all defensive 

backs and linebackers to any positions on the field you would 
like.  Without your moving them, the players will remain 
where they are, covering their respective zones. This is your 
typical �bend but don�t break� defense.  Zone coverages uses 
player�s zone coverage rating (D), except on passes in the 
flats. 

• Man---Calling a man coverage assigns each of your 
defenders (LB�s and DB�s) to an offensive player.  Your 
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defenders will follow the offensive players wherever they go 
on the field.  Unfortunately, if a run is called, this means that 
they will sometimes be out of position covering a deep pass, 
leaving a zone vacated.  Man coverage uses the player�s 
man coverage rating (E), unless the pass is in the flats. 

• Combination---Combination coverage assigns man 
coverage to your cornerbacks and puts all the other players in 
zone.  This eliminates some of the worry of a wideout going 
deep with only a free safety covering him.  But it does allow 
gaps in your defense, which you will need to cover with your 
linebackers and safeties.  The cornerbacks in this coverage 
will have their man (E) coverage ratings used.  Other 
defenders will use their zone (D) coverage ratings. 

• Prevent---This is the same as zone defense, except that the 
safeties drop into the deep zones and the linebackers drop 
from the short pass zones into the medium pass zones.  It 
would be unwise to be in anything but a nickel or dime 
package in this scheme, unless you have outstanding 
coverage linebackers.  This defense is particularly prone to 
short passes, draws, and runs. 

Keying and Double-Teaming 
• Keying---To key on a running back, select that option from 

the �DEFENSE� menu, and select the back you want to key 
on.  The fullback will always be the back on the strong side of 
the formation (the right side) or the up back.  The halfback is 
always the back on the weak side of the formation (the left 
side) or the deep back.  Keying on a runner makes player 
number 5 (the middle linebacker or the right inside 
linebacker) follow that player around the field.  It does NOT 
necessarily mean that the runner keyed on is going to get 
pummeled at the line of scrimmage.  It does increase the 
likelihood, however, that the defense will create a �stack� of 
two players in a zone, effectively limiting the running back to 
little or no yardage.  On the other hand, an incorrect key will 
open holes in your defense for the other running back. 

• Double-Teaming---Any of the five receivers on the field may 
be double-teamed.  When doing so, the free safety (player 
number 10) will follow that player around the field, even if 
another defender is already in the same zone.  Again, this 
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does not mean that the player cannot catch the ball, but it will 
insure that the player is covered. 

 
Other Defensive Strategies 

These strategies are not among those listed under the 
�DEFENSE� menu.  Instead, it is necessary to physically 
move players around the field by dragging and dropping them 
into the new zones you�d like. 

• Stacking---Linebackers and defensive backs may be 
�stacked� behind defensive linemen.  This will increase the 
likelihood that two defenders will close in on the ball carrier 
and �stuff� him.  However, it also increases the likelihood that, 
if the carrier breaks through the first line of defense, he will 
make a big play. 

• Blitzing---Only players positioned in the front half of the front 
defensive zones are rushing the passer.  To have a 
linebacker or defensive back blitz, he must be moved into the 
front half of a zone before the completion of the play.  The 
more players you blitz, the higher the likelihood of disrupting 
the offense�s play. 

 
Defensive Player Movement 

Defensive players may be moved to ANY defensive zone before the 
offense snaps the ball.  After the snap of the ball, defensive players 
may only move laterally, forward, or backward one zone.  You may 
attempt any movement, but the computer will disallow those of more 
than one zone.  When a player is under the computer�s control (in the 
case of a linebacker keying, a safety double-teaming, or in the case of 
a defender in man coverage) the players may sometimes move more 
than one zone in order to �keep up� with the offensive player. 

In addition to the drag and dropping of players into new zones, one 
can also display a player�s card.  In order to do this, double-click on 
the player with the RIGHT MOUSE BUTTON.  By double-clicking on a 
player, his �card� will appear on the screen.  You may also view a 
player�s �A B C D E� ratings (�x A B C D E� for offense) simply by 
placing the mouse over the player you want to look at.  The �Tool Tip 
Text� will then be activated to show you the player�s basic ratings. 

To stop a running play, a defensive coach should try to �stack� 
players in an area he believes is being attacked.  You may do this in a 
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number of ways, but the two most common are to move up a safety or 
slide over a linebacker.  Keep in mind that if the running back makes it 
through your first line of defense, he�s likely to break away for a long 
gainer.  If keying on a running back, one of your linebackers will slide 
over and will usually �stack� behind a defensive lineman.  The more 
defensive players in an area being attacked, the better chance the 
defense has of stopping the run. 

 
 
  Deep Pass Zone 
 
 
 
  Medium Pass Zones  
 
 
      

  
     
     
 1 2  3 4 5 6 7  
     
  Running Lanes and Pass Rush Lanes 
 
To stop passes, you can either elect to disrupt the quarterback by 

putting on a strong rush, or cover the receivers in the best manner 
possible. 

Players in the front zones (the rushing zones) will rush the 
quarterback (AND stop the run), while players in the back halves will 
guard against running plays and draw plays and will be allowed to 
drop back into coverage or blitz.  On short pass plays, ONLY the 
middle 5 rushing zones (labeled 2 through 6) will rush the QB.  On 
medium pass plays, the two outside rush zones (labeled 1 and 7) have 
the same likelihood as being called as do lanes 2 through 6, and on 
long passes, the outside rush zones (1 and 7) will be called twice as 
often as any of lanes 2 through 6.   

If you suspect that your opponent will call a screen or flat pass, you 
should not send a blitz through lanes 1 and 7.  Instead, concentrate on 

Linebacker Zones 
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lanes 2 through 6 and cover receivers in the linebacker zones (the 
flats). 

If you suspect your opponent will attempt a long pass, you might then 
want to either slide your defensive ends out (into lanes 1 and 7) or 
send a linebacker or d-back on a blitz in these lanes. 

Blitzing adds bonus points to your player�s defensive rush rating 
(column �B�).  The more players who rush the passer, the more bonus 
points your defense receives.  Blitzing a safety or cornerback from 
their natural position adds even more points.  Of course, blitzing 
usually results in leaving a vacated area.  A �wise� quarterback can 
pick up a blitz more easily than an untested rookie.  Look at a 
quarterback�s �Audible� rating to see how well he handles pressure.  
As the middle rushing zones (lanes 2-6) already receive attention from 
pass rushers on all passes, a blitz bonus is not added for linebackers 
rushing from the linebacker zone directly behind lanes 3-5. 

 
Playing Offense 

As offensive coach, you will select 
from a group of plays for the 
formation you are running.  
Formations may be changed from 
the Offense menu.  You may also 
bring in new �packages� (groups) of 
players from the Package option in 
the Offense menu.  Note that 
bringing in a new package does 
NOT change the formation. 

Players are identified by the abbreviations �HB�, �FB�, �F1�, �S1�, 
�T1�, etc.  Check Appendix 3 for the player positions for each 
formation. 

Making sure that you have the correct personnel in the game for a 
particular play is necessary for its success.  If you don�t like your 
personnel, you need to change the players before the defense 
indicates it is ready. 

You may get a better idea of how a play will unfold by clicking on the 
display button after checking a play in the play list. 

 
Calling Audibles 
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At times, you may see something in the defense which makes you 
wish you could change plays.  This can be done by clicking on the 
�AUDIBLE� button.  The computer may disallow the move by 
automatically snapping the ball.  (This tendency is a function of the 
player�s ability to recognize audible situations, whether the QB is 
playing for the home team or visiting team, and the score.)  If the 
audible is allowed, a list of new plays pops up, from which you will 
select a play as you did previously. 

Offensive players may not be moved using the drag-drop method 
explained earlier for defensive players.  You may view the player�s 
�card� and his game statistics by double-clicking on him. There is no 
option for turning on or off this view option. 

 
The Snap of the Ball 

Once the defense indicates they are ready, the ball is snapped to the 
quarterback.  Each of the �skilled� position players advances, giving 
some indication of what is going on in the play.  Watch out...it might 
be a trap! 

At this time, the defense may move its players around the field to 
adjust to the offensive team�s movement.  As explained earlier, each 
player may only be moved one zone in this sequence, unless some 
special circumstances (a key, double-team, etc.) prevail. 

When ready, the defense clicks on the button �DEFENSE READY� 
and the play concludes.  The �ball� will travel to the location next to the 
player the play was intended, and a text box will appear giving a brief 
account of what happened on the play. 
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Fatigue 
Offensive skill players have been given a Fatigue rating from 0 

(normal) to 5 (superior).  Every time a player is the intended receiver 
on a pass, or the ball carrier on a running play, he accrues target 
points...2 for a pass attempt, 1 for a rush attempt.  When a player hits 
his target limit (see table below), his team is penalized each time he is 
used, unless he is given a rest. 
 

 
Fatigue 
Rating 

Target 
Points 

0 10 
1 15 
2 20 
3 25 
4 30 
5 35 

 
Resting a player will �refresh� him, 

subtracting 5 target points from his 
total.  The rest period is 10 plays in 
duration. 

In order to rest a player, use the 
Offense menu, or double click on the 
player and use the �Rest Player� 
button. 

Players also gain back target points 
when their defense is on the field. 

Players lose some of their 
effectiveness when they are fatigued.  
The more  they surpass their target 
point total, the less effective they 
become.  Eventually, they will become 
a hindrance to your offense. 

Players receive their endurance ratings due to real-life usage.  The 
fatigue system may be turned on or off at the game options screen. 

 
Player Card in Game 

Module 
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Defensive players also have a fatigue rating (again from 0 to 5) and 
begin tiring for two reasons; (1) the cumulative number of plays they 
have been on the field during the course of the entire game and (2) 
the number of successive plays they have been on the field.  Bringing 
a player out to catch his wind will break up some of the effects of 
number 2 above.  Field conditions, such as heat, will also effect a 
player�s fatigue level. 
 
Time Management 

There are 15 minutes (900 seconds) per quarter.  In order to 
conserve time, you may choose HurryUp from the Speed Setting 
portion of the Offense menu.  Likewise, you can select SlowDown or 
Normal.  Timeouts may also be called by either offense or defense 
from their respective menus. 

At the end of the half, human coaches will be warned if they have an 
opportunity to stop the clock before the half expires.  If the preceding 
play occurred with less than 15 seconds remaining on the clock, no 
such opportunity is presented, and the clock will usually expire 
automatically. 

 
Viewing Statistics 

At nearly any time during the course of a game, you may view 
statistics.  Press Stats from the menu, and a new window will appear.  
You may select breakdowns of rushing, receiving, passing, punting, 
kicking, returning, and defense by selecting them from the 
Breakdowns menu. 

In addition, you may view a stats Log of the game by pressing this 
menu.  It will give you a play-by-play account of what has transpired 
during the contest.  More information about the log is included in the 
appendix. 

A stats �window� is also at the bottom of the game screen, making 
visible some of the game statistics for the current skilled position 
players. 

 
Saving and Loading a Game 

To save a game already in progress, select Save Game under the 
File menu.  The game will automatically be saved in the directory 
where the player file is stored. 
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To load a saved game, you must load the appropriate player file and 
select Load Game from the File menu of the football program.  The 
game conditions will automatically be loaded and the game will take 
off from the point where it was saved. 

 
Post Game Options 

At game�s end, you will have the option of viewing and/or printing the 
game statistics.  You may also save them for later compilation. 

The Save menu has two options�saving a Box Score or Stats for 
Compiler.  Both will give the file a default name, such as 
�Den1SD.GST�, which means Denver (Den) in a league 1 (1) game at 
San Diego (SD).  The �.GST� extension stands for �game stat� file.  In 
the case of a box score, the name will be identical except for the 
extension, which will be �.TXT� (text file). 

After saving the Stats for Compiler, the program will end.  If you 
forgot to make a box score, you can always do it later from the 
organization program. 
 
Stats (from ORG.EXE) 

The Stats module of 4th St. Sports Computer Football can be 
accessed through the Options menu of the Organize program.  
Running the Stats module will allow you to view previously compiled 
statistics, print individual game logs and compile stats files.   

After loading the appropriate player file, you may change leagues by 
selecting the one you want from the League menu.  You may then 
select a team and select Stats from the Options menu.  You can then 
view any of the stats already compiled by the selected team.  You can 
also run a leaders board, print league standings, print league 
rankings, and print a team stats report. 

To compile a stats file, select Compiler from the menu.  The main 
screen of this program looks like this: 
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The Stats 
Compiler Screen 

 
Pressing the 

�SELECT FILE� 
button will allow 
you to select a file 
to compile.  All 
game stat 
(extension .GST) 
files will appear in 
the file list 
window after you 

select the appropriate path.   
The �COMPILE ALL� button is used when compiling stats from an 

autoplay replay session. These files use a different naming convention 
than games played normally�they are given a name and number 
such as �REPLA021.GST�. 

You may select files from other drives and directories, if you wish.  
Upon compiling them, all stats will be entered into the team file 
directory. 

After selecting a file, the teams involved in the game will appear in 
the label boxes shown above. 

The first time you select a file for a league, the computer will write a 
player stat file and a team stat file.  This will take some time, as a 
record must be made for each of the players and teams in the league. 

Pushing on the �COMPILE� button will compile individual and team 
statistics.  When finished, it will change the selected file�s name to 
�BACKSTAT.XXX�, if you choose that option when prompted.  You 
can back up to 999 files in a single directory. 

The �COMPILE ALL� button does the same thing that the COMPILE 
button does, except it compiles all the GAMESTAT files in the current 
directory.  Each stat file will be backed up as a �BACKSTAT.XXX� file 
after being compiled if you choose that option. 

The PRINT IND, PRINT LOG and VIEW STATS buttons will do the 
same things as the menus in the stats display screen in the game 
program. 
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Pressing Exit will bring you back to the original Stats display screen. 
There may be times when you want to �restart� a league, zeroing all 

the statistics and canceling all injuries.  To do so, just push the Restart 
menu in the Stats module.  To rest players ONLY,  use the Rest 
Players option in the Organize module (Options menu). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Appendix 1 
Stats Display 
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When the �LOG� menu is selected, a stats log of the game will be shown on screen.  Selecting 
this menu again will toggle through the next 20 plays (or bring up the very first 20 plays). 

The heading of the logs screen contains the following: 
 

Num  Q  Dn  TG  CLK  YL  PS  P#     BC    Pa   Yds   To  RT    RY    Pn  FG  FD  Of  Df  Wn 
 

The following are the definitions for these codes: 
 

Num actual play number of the game 
Q quarter 
Dn down 
TG yards to go for first down 
CLK time at the beginning of this play 
YL starting yard line of this play (100 is visitor�s goal line, 0 is home team�s goal line) 
PS team with possession 
P# play call number 
BC ball carrier 
Pa passer 
Yds yards made on this play 
To turnover result (�I� for interception, �F� for fumble lost, �f� for fumble recovered) 
RT returner (only on kicks, punts, turnovers) 
RY return yards 
Pn penalty yards (negative yards indicates penalty was on offense, positive on defense) 
FG field goal result (�FG� is good, �FN� is no good, �XG� is kicked extra point good, �XN� 
  is extra point no good) 
FD first down (�FD�) or touchdown (�TD�) 
Of offensive player in matchup 
Df defensive player in matchup 
Wn winner of matchup 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Appendix 2 
Result Codes Table 
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00 No gain 
01 1 yard gain 
02 2 yard gain 
03 3 yard gain 
04 4 yard gain 
05 5 yard gain 
06 6 yard gain 
07 7 yard gain 
08 8 yard gain 
09 9 yard gain 
10 first down (or, 1 yard from first down...50% chance.  Maximum of 10 yard gain) 
11 10 yards + d10 roll (10-19 yards) 
12 10 yards + d10 roll (10-19 yards) + clipping penalty (illegal block in the back) 
13 10-19 yard punt which flies out of bounds 
14  
15 illegal motion 
16 pass interference, offense 
17 pass interference, defense 
18 delay of game, offense (may be negated by calling QB calling timeout) 
19 holding, offense 
20 holding, defense 
21 20 yards + d10 roll (20-29 yards) 
22 no gain.  Player injured (player LOSING matchup is injured) 
23 20-29 yard punt which flies out of bounds 
24 0-9 yard gain.  Player injured (player LOSING matchup is injured) 
25 10-19 yard gain.  Player injured (player LOSING matchup is injured) 
26 incomplete pass.  Player injured (player LOSING matchup is injured) 
27 20-29 yard gain.  Player injured (player LOSING matchup is injured) 
28 0-9 yards.  Personal foul 
29 10-19 yards.  Personal foul 
30 incomplete pass.  Personal foul 
31 30 yards + d10 roll (30-39 yards) 
32 30-39 yard punt which is very high and may be fair caught 
33 30-39 yard punt which flies out of bounds 
34 blocked pass 
35 0-9 yards.  Grasping face mask penalty 
36 10-19 yards.  Grasping face mask penalty 
37 0-9 yards.  Twisting face mask penalty 
38 10-19 yards.  Twisting face mask penalty 
39 encroachment penalty 
40 field goal (or extra point) hits crossbar.  50% chance of being good 
41 40 yards + d10 roll (40-49 yards) 
42 40-49 yard punt which is very high and may be fair caught 
43 40-49 yard punt which flies out of bounds 
44 blocked kick 
45 quarterback is forced to run on a passing play 
46 incomplete pass 
47 quarterback sack 
48 quarterback sack and fumble 
49 quarterback sack and injury to player losing matchup 
50 field goal (or extra point) is good 
51 50 yards + d10 roll (50-59 yards) 
52 50-59 yard punt which is very high and may be fair caught 
53 50-59 yard punt which flies out of bounds 
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54 0 yard gain.  Fumble 
55 0-9 yard gain.  Fumble 
56 10-19 yard gain.  Fumble 
57 20-29 yard gain.  Fumble 
58 30-39 yard gain.  Fumble 
59 40-49 yard gain.  Fumble 
60 field goal (or extra point) is no good 
61 60 yards + d10 roll (60-69 yards) 
62 interception 0-9 yards behind the line of scrimmage 
63 interception 0-9 yards downfield 
64 interception 10-19 yards downfield 
65 interception 20-29 yards downfield 
66 interception 30-39 yards downfield 
67 interception 40-49 yards downfield 
68  
69 incomplete pass.  Grasping face mask penalty 
70 kickoff out of bounds penalty 
71 70 yards + d10 roll (70-79 yards) 
72 touchback 
73  
74  
75  
76  
77  
78  
79  
80  
81 80 yards + d10 roll (80-89 yards) 
82 0-9 yard loss 
83 1 yard loss 
84 2 yard loss 
85 3 yard loss 
86 4 yard loss 
87 5 yard loss 
88 weird play 
89 automatic touchdown 
90 0-9 yard gain 
91 90 yards + d10 roll (90-99 yards) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Appendix 3 
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Offensive Formation Identification Table 

 
Pro Set 
 
  S1 T G C G T T1 
     QB    F1 
    HB  FB 
 
 
Two Tight End 
 
  T2 T G C G T T1 
     QB    F1 
    HB  FB 
 
 
�I� 
 
  T2 T G C G T T1 
     QB    F1 
     FB 
     HB 
 
Shotgun 
 
  S1 T G C G T T1 
 F2        F1 
     QB HB 
 
 
Ace 
 
  S1 T G C G T T1 
 F2    QB    F1 
 
     HB 
 
 
Run and Shoot 
 
  S1 T G C G T S2 
 F2    QB    F1 
 
     HB 
 
S1 = Split End #1  C = Center 
S2 = Split End #2  G = Guard 
F1 = Flanker #1   T = Tackle 
F2 = Flanker #2   T1 = Tight End #1 
HB = Halfback   T2 = Tight End #2 
FB = Fullback 
QB = Quarterback 
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Ratings Idenfication Key 
 Off Linemen QB�s RB�s WR�s  TE�s 
A powr run blk inside run inside run inside run inside run 
B quick run blk scramble speed run outside run outside run 
C short pass blk short pass short pass rec short pass rec short pass 
rec 
D med pass blk medium pass med pass rec med pass rec med pass 
rec 
E long pass blk long pass long pass rec long pass rec long pass 
rec 
x <-----------------------------------------supplemental blocking rating-------------------------------------
-> 
 Def Linemen LB�s DB�s 
A run defense run defense run defense 
B pass rush pass rush pass rush 
C short pass cov short pass cov short pass cov 
D med pass cov med pass cov zone pass cov 
E long pass cov long pass cov man pass cov 
x <------------supplemental blocking rating-----------------> 
 
Average Ratings By Position 
 OL QB RB WR TE  DL LB DB 
A 7 5 7 5 6  3 3 2 
B 7 6 7 6 5  3 3 2 
C 7 7 7 7 7  1 3 3 
D 7 7 6 7 7  0 2 3 
E 7 7 5 7 5  0 1 3 
x 5 1 5 3 6  3 3 3 
 
Average Yardage on Rushing Plays By Position 
 OL QB RB WR TE  DL LB DB 
 6.0 -.- 10.0 3.0 5.0  0.0 1.0 2.0 
 
Average Yardage on Passing Plays By Position 
 OL QB RB WR TE  DL LB DB 
short 8.0 11.0 15.0 15.0 15.0  5.0 1.0 1.0 
med 12.0 20.0 15.0 20.0 20.0  15.0 8.0 8.0 
long 25.0 30.0 25.0 40.0 25.0  40.0 25.0 25.0 
 
Average Completion Percentage on Passing Plays By Position 
 OL QB RB WR TE  DL LB DB 
short 100% 90% 90% 80% 90%  90% 85% 75% 
med 90% 75% 50% 80% 60%  45% 20% 10% 
long 45% 40% 20% 60% 30%  20% 10% 0% 
 
Average Sack Percentage on Passing Plays By Position 
 OL QB RB WR TE  DL LB DB 
all 0% 0% 0% 0% 0%  40% 40% 40% 
 
Average Interception Percentage on Passing Plays By Position 
 OL QB RB WR TE  DL LB DB 
short 0% 0% 0% 0% 0%  2.8% 8.3% 8.3% 
med 0% 0% 0% 0% 0%  2.8% 11.1% 13.9% 
long 0% 0% 0% 0% 0%  2.8% 13.9% 27.8% 
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Returns Table 
 A B C D E F G H I J 
2 Long Long Long Long Long Long Long Long Long Long 
3 64.5 54.5 54.5 44.5 44.5 44.5 34.5 34.5 34.5 34.5 
4 54.5 54.5 44.5 44.5 44.5 34.5 34.5 34.5 34.5 24.5 
5 44.5 44.5 34.5 34.5 34.5 34.5 34.5 24.5 24.5 24.5 
6 34.5 24.5 24.5 24.5 24.5 24.5 24.5 24.5 24.5 24.5 
7 24.5 24.5 24.5 24.5 24.5 24.5 14.5 14.5 14.5 14.5 
8 24.5 24.5 24.5 24.5 24.5 14.5 24.5 24.5 14.5 14.5 
9 34.5 34.5 34.5 24.5 14.5 24.5 24.5 14.5 24.5 4.5 
10 34.5 34.5 34.5 34.5 34.5 24.5 14.5 24.5 4.5 24.5 
11 44.5 44.5 44.5 44.5 34.5 34.5 34.5 24.5 24.5 14.5 
12 54.5 54.5 54.5 44.5 34.5 34.5 24.5 24.5 24.5 24.5 
Avg 37.1 35.1 33.1 31.1 29.1 27.1 25.1 23.1 21.1 19.1 
 
 K L M N O P Q R S 
2 Long Long Long Long Long Long Long Long Lon 
3 24.5 24.5 24.5 24.5 24.5 24.5 24.5 14.5 4.5 
4 24.5 24.5 24.5 24.5 24.5 24.5 4.5 14.5 4.5 
5 24.5 24.5 24.5 14.5 14.5 14.5 4.5 4.5 4.5 
6 24.5 14.5 14.5 14.5 14.5 4.5 14.5 4.5 0 
7 14.5 4.5 4.5 4.5 4.5 4.5 4.5 0 -4.5 
8 4.5 14.5 4.5 4.5 4.5 4.5 0 -4.5 4.5 
9 14.5 14.5 14.5 14.5 4.5 0 -4.5 4.5 0 
10 14.5 14.5 14.5 4.5 0 -4.5 4.5 0 0 
11 14.5 14.5 4.5 0 -4.5 4.5 0 0 0 
12 14.5 4.5 0 -4.5 4.5 0 0 0 -4.5 
Avg 17.1 15.1 12.9 10.6 9.0 7.1 5.0 3.1 0.9 
 
 
Note:  The �Long� run may be moved to the player�s �LongFreq� location (example, a �LongFreq� 
rating of �7� puts the �Long� return at a dice roll of 7, rather than 2). 
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A 

abbreviation 10 
Audible 28 
AutoFill 12 
AutoPlay 20 

B 

Blitzing 26 

C 

Coach 16 
Combination 25 
COMPILE 33 
Coverage 24 

D 

Defense 23 
Defensive Player Movement 26 
Double-Teaming 25 
Drafting 9 

F 

Fatigue 30 
FB.EXE 5, 19 
File menu 7 

G 

Game Options 20 

I 

Installing 4 

K 

Keying 25 

L 

League 7 
load 31 
LOG 33 

M 

Man 24 
Manual Terminology 5 

O 

Offense 28 
Options 8 
ORG.EXE 5, 6 

P 

Platoons 12 
Player Editor 15 
Post Game Options 32 
PRE-SPECIFIED 20 
Prevent 25 

R 

ratings 3 
Ratings 1 
Resting Players 19 
Run Sched 20 
Run Schedule 21 

S 

Save 31 
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SEARCH 11 
SELECT YEAR 6 
Setup 7 
Snap 29 
Stacking 26 
Statistics 

Stats 31 
Stats Compiler 33 

T 

Time Management 31 

Z 

Zone 24 
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